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Introduction  
This document outlines all issues that should be considered and presented to customers 
before upgrading them to Interwise Connect Version 7.2. 

Interwise will begin upgrading customers to V7.2 during July/August 2006. For a detailed 
list of the new features in V7.2, see the What’s New in V7.2 document (you can find it on the 
Product Portal). 

Ideally, customers should upgrade the ICC, Participant application, Outlook AddIn, ICS and 
ITS all at the same time. When this is not possible (mostly in big organizations), these 
organizations should be aware of the compatibility issues. 

This document is also relevant for V5.2 and V6.0 customers. Customers who are working 
with V5.2 may also be interested to know about the new features/enhancements in V6.2, as 
described in the What’s New in V6.2 document. 

 
Note: Mixed environments of V4.2 or V4.5 with V7.2 are not supported. 

 

Future Releases 
Charlie version will be released at the beginning of 2007. More information about Charlie 
version can be found in the Product Portal on the Roadmap page.  
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Upgrading Interwise Applications 
This section describes how to upgrade Interwise applications and also includes limitations 
that should be taken into consideration. 

 Upgrading the Interwise Communications Center (ICC), see below 
 Upgrading the Interwise Participant Application, see below  
 Upgrading the Interwise Moderator Application, page 7 

 Upgrading the Interwise Outlook AddIn, page 7 

 Upgrading IWMaterials, page 8 

 Integrations, page 9 

 Localized Versions, page 10 

 System Requirements, page 10 

 Supported OS/Browser Roadmap, page 11 

 Features no longer supported in V7.0, page 11 

 

Upgrading the Interwise Communications Center (ICC) 
 

 
Note: If the ICC configured to work with HTTPS for the login page, See the HTTPS 
Environment section. 

Upgrading V5.2 ICC to V7.2 ICC 
V5.2 can be upgraded directly to V7.2 using the dual-machine or the single-machine upgrade 
tools (The single-machine upgrade tool upgrades to V7.0 and then the customer needs to 
apply the V7.2 ICC patch).  

Using the dual-machine upgrade tool, it is possible to upgrade selected V5.2 VICCs (one or 
more at a time even if there are several VICCs installed on one machine). The single-
machine upgrade tool upgrades the entire ICC machine with all its installed VICCs.    

Upgrading V6.0 ICC to V7.2 ICC 
V6.0 can be upgraded directly to V7.2 using the dual-machine upgrade tools.  
On-Site customers can run an ICC patch to upgrade their ICC from V6.0 to V7.2. 

Upgrading V6.2 ICC to V7.2 ICC 
There is only a limited number of customers who have V6.2 ICC installed. All of them have 
on-site installation. An ICC patch can be installed on V6.2 ICC to upgrade them from V6.2 
to V7.2. 

Upgrading V7.0 ICC to V7.2 ICC 
An ICC patch can be installed on V7.0 ICC to upgrade the ICC from V7.0 to V7.2. 
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Upgrading the Interwise Participant Application 
The Participant application has several installation packages: 

IFTW: An installation package that is downloaded to the user from the web using a ‘smart 
engine’. Typically the installation is downloaded to the user computer during the event entry 
process either as a fresh installation or in the form of an upgrade. 

Disk 1: Standard installation in the form of setup.exe. The package is typically used by 
organizations that are looking into deployment using software distribution system that do 
not use MSI. Another reason to use this package is that, like the IFTW, it supports 
installation on locked down desktops by users without administrator rights.  

MSI package: MSI package that follows the Windows Installer standards. The package 
allows system administrators to deploy the application using SMS or similar products while 
enjoying all the benefits of Windows Installer such as self-recovery.  

By default, the Participant application is installed under C:\Program Files\Interwise  

The data files, such as log files and Materials will be saved by default under an Interwise 
folder located in the My Documents personal folder of the user, for each user. 

When installing the Participant application on a machine in which the application is already 
installed, the new Participant application will be installed to the existing path (unless the 
‘keep settings’' install property is disabled).  

The Participant application can be installed/upgraded in one of the following ways: 
 Any user with login rights to the ICC can independently download the Participant 

application from the Download area in the ICC interface. 
 The ICC System Administrator can set the Participant ‘minimum version’ to be V7.2. 

This will automatically download the V7.2 Participant application to users upon entering 
an Event if they do not already have this version installed.  

 IT managers can distribute the Participant MSI package or Disk1 to all the users using a 
distribution application, such as Microsoft System Management Server (SMS). 

Limitations 

 A Participant application that was installed using the Interwise MSI package, cannot be 
upgraded using the Disk1 or IFTW (this is because these are different installation packages).  

 The Interwise MSI package can upgrade only installations that were performed using an 
MSI package. 

 An upgrade run by an admin user over an existing installation by a non-admin user is not 
supported (this is because the installation places files and registry entries in different 
locations based on the permissions of the user). 

 An upgrade run by a non-admin user over an existing installation by an administrator is 
also not recommended though it will usually work fine. 

 Interwise installations (MSI, IFTW or Disk1) cannot be used to upgrade MSI packages 
of the Participant application that were developed by the customer. The customer must 
first uninstall the already installed Participant application.   
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 IFTW V7.2 can replace V5.2. To allow this, the Student.ini file needs to be edited so that 
the program installation path will not include environment variables such as 
%ProgramFiles%. Instead, you should specify a specific fixed path such as 'C:\Program 
Files\Interwise\Participant'. In the case that the end user is running the Java flow for 
Event Entry, the Participant application will be downloaded each time from scratch. 

 
Note: There is no prevention of using environment variables in the data installation path and 
therefore it is recommended to leave the default that appears in the Student.ini file (%My 
Documents%\Interwise\Participant).  

Upgrading the Interwise Moderator Application 
The Participant application V7.0 and above cannot coexist on the same computer with the 
Moderator application from version 6.0 and below. Therefore, the installation of the 
V7.0/V7.2 Participant uninstalls any previously installed Moderator versions. The 
installation of the Participant application run by an administrator (Disk1, IFTW or MSI) 
removes the shortcuts to the Moderator application from the user’s desktop and START 
menu. 

The MSI package and Disk1 installation will also perform a silent uninstalling of the 
Moderator application while installing the Participant application. The IFTW will not do so 
in order to prevent conflicts with the silent asynchronous installation of the ImageMaker 
print drivers. 

To have the off-line capabilities, such as: preparing Event Materials, Upload Event Materials 
to the ICC and Recording Editing, you will have to install the Materials Editor AddIn.  

The Materials Editor AddIn, is an MSI installation that requires Admin Rights. Before 
installing the Materials Editor AddIn, you must first install the Participant application.  

When un-installing the Participant application, the Materials Editor AddIn will also be un-
installed, if the Disk1 installation was used to install the Participant application. If the 
Participant application has been installed using the MSI installation, then un-installing the 
Participant application will not un-install the Materials Editor (although it will no longer 
work).  

Limitations  
 An upgrade run by a non-admin user will not uninstall the Moderator application and 

will not remove the shortcuts to the Moderator application from the user’s desktop and 
START menu. 

 The IFTW of the Participant application does not uninstall the Moderator application. 
Therefore, customers should first uninstall the Moderator application and then install 
V7.2 of the Participant application.  

 The Materials Editor AddIn requires Admin Rights. 

 

Upgrading the Interwise Outlook AddIn (OA) 
The V7.2 Outlook AddIn installation file is a standard MSI package. The OutlookAddIn.exe 
installation file is no longer available starting V7.0. 
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The Outlook AddIn can be installed/upgraded as follows: 
 IT managers can distribute the Outlook AddIn MSI package to all users using a 

distribution application, such as Microsoft System Management Server (SMS). 

 
Note: V7.2 of the Outlook AddIn can be installed over Outlook AddIn V6.x/V7.0. It cannot be 
installed over V5.2.  

Limitations 
 Version 6.0 and above of the Outlook AddIn is not backward compatible with version 

5.2 of the Outlook AddIn. Customers who are using V5.2 and wish to upgrade to V7.2 
must first uninstall the V5.2 Outlook AddIn. Mixed environments of V5.2 and 
V6.0/V7.x are not supported.   

 V7.x of the Outlook AddIn cannot work with ICCs of versions 5.2.  
 V5.2 of the Outlook AddIn cannot work with ICCs of versionV6.0 or V7.x ICC. This 

means that V5.2 customers wishing to use the Outlook AddIn should uninstall the V5.2 
AddIn and install the V7.2 AddIn once the ICC is upgraded to V7.2.  

 The Outlook AddIn can only be installed by user with administrator rights on the machine.  

 
Tip: Customers can use the Interwise uninstaller tool to uninstall an Outlook AddIn from 
version 5.2 or below. The tool is built in the form of an installation file so it can be distributed in 
the same method that will be used to distribute the installation of the new AddIn.  
 

     Outlook AddIn and ICC Compatibility: 
  

 ICC 5.2 ICC 6.0 ICC 7.x 

Outlook AddIn 5.2 √ Not supported Not supported 

Outlook AddIn 6.0 Not supported √ √ 

Outlook AddIn 7.x Not supported √ √ 
 

Upgrading IWMaterials 
The IWMaterials is an ActiveX control that is used to upload materials to the ICC. The 
IWMaterials is installed with the Outlook AddIn, Lotus Notes AddIn, Participant 
application and is also automatically installed from the ICC when uploading materials (if the 
user does not already have IWMaterials installed).  

All applications (ICC, Outlook AddIn and Lotus Notes) use the latest IWMaterials that has 
been installed.  

Installing the IWMaterials directly from the ICC requires the user to allow signed ActiveX 
controls to be installed from the web. Typically, organizations prefer to distribute the 
IWMaterials as part of the Outlook AddIn or Participant application installation. In some 
rare scenarios, customers distributed the IWMaterials using a customized installation package 
they built independently based on installation instructions from Interwise. 
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Interwise recommends upgrading the IWMaterials in the same method that was used to 
install its previous version. At the same time, installations of the Participant application and 
Outlook AddIn will always upgrade the existing version of the IWMaterials. 

Organizations that do not wish to upgrade the IWMaterials from the ICC should modify a 
file named ActiveX.txt on the ICC machine under \InterWise\wwwVc\IWCampus\ 
English\ActiveX. The file includes the minimum allowed version of the IWMaterials for 
users in the ICC. The ICC will not upgrade the IWMaterials for users that already have a 
version equal or greater than the version number that appears in the file. 

Please note that the settings in the file will apply to all the VICCs that are installed on the 
ICC machine. 

 
HTTPS environment 
Previous to V7, the ICC supported HTTPS only on the login page. Starting V7, the ICC 
supports HTTPS on all of its pages and no longer support HTTPS for the login page only.  
In most upgrades the ICC and clients are not being upgraded at the exact same date. To 
keep the security level they previously had in the ICC throughout the entire upgrade process, 
you should follow the steps below: 
 
Step 1: 
1. Upgrade the ICC to V7.2. The ICC should be configured to force browser-users to 
browse over HTTPS and not over HTTP. For that, you should select the ‘Force HTTPS on 
login screens’ checkbox in the /Services page.  
 
2. Since the client applications were not yet upgraded to V7.2, the ICC should ‘publish’ itself 
to its users with its HTTP URL. For that, you should set the ‘Return HTTP for non HTTPS 
components’ to be ‘1’.  
 

Set the following Application Parameter to be 1. 

Group Sub-
group 

Key Value 

Security 

 

Security Return HTTP for non HTTPS components 1 

 

Step 2: 
Participant application:

Distribute  the V7.2 Participant applications.  
The new client application should be installed with the HTTP URL of the ICC (for My 
Interwise). In addition, the Participant installation should be configured to support HTTPS  
as described in HTTPS Configuration Guide.pdf. 
 
Outlook AddIn: 
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In order to prevent the user from making mistakes, it is recommended to pre-configure the 
Outlook AddIn installation package so it will already include the ICC URL with the 
‘https://’ prefix.  

Please refer to the ‘Implementation Guide for the Outlook AddIn’ (under: Defining the 
displayed Server list’ section)  for further details.  
 

Step 3: 

ICC  

After upgrading all the client applications to V7.2 with the HTTPS support, update the value 
of Return HTTP for non HTTPS components to be 0. 

Servers 

Not must 
Configure the ICS to support HTTPS  as described in HTTPS Configuration Guide.pdf. 

 

Integrations 
Customers who have a custom integration, such as integration with Active Directory, 
Reverse Proxy or SSO or integrated to Interwise using Interwise API calls, should contact 
Interwise 3rd level support before upgrading. Some of the integration will require 
modifications, and therefore needs to be treated as an integration project.  

 

Localized Versions 

 
Note: Before applying any patch, service pack or upgrading a localized ICC machine, you should 
contact 3rd level support. 

A Japanese Enabled ICC (or any other future version that will be enabled) is similar to the 
English version. Once the upgrade is finished, you will be asked to run a language pack over 
the new version. 

Limitations 
 Running an ICC English patch on a localized ICC is not supported.  
 The Upgrade tool does not work with Localized versions of the ICC. Customers who 

have a localized ICC installed, can only run a clean installation.  
 

System Requirements 
Interwise Connect has both front end components (such as the Participant application and 
Outlook AddIn), experienced by Interwise end-users, and backbone components (such as 
ISM, ICC, IPP and ICS), utilized by system administrators to create a supporting 
environment that enables the Interwise Connect experience. 
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For a detailed list of the system requirements for each component (Participant application, 
Outlook AddIn, ICC etc), please refer to the V7.2 System Requirement document. 

 

Supported OS/Browser Roadmap 
 

OS/Office/Browser Support expiration date for 
V5.2 / V6.0 

V7.x 

Windows NT 4 (Server and 
workstation) 

End of 2005 Not supported 

Windows 98 (initial release 
and second edition) 

End of 2006 Not supported 

Internet Explorer 5.xx End of 2006 Not supported 

Windows Server 2000 
(Advanced Server and 
Datacenter) 

End of 2006 Not supported 

 

Features No Longer Supported starting V7.0  
From V7.0, there are a number of features that are no longer supported.  

 The GetBilling.asp call is no longer supported. Customers who wish to get billing 
information should use the GetAttendance.asp call instead.  

 The Calendar view is no longer available in the ICC Catalog. 
 The ‘Only Moderator may use Telephone’ option (under Event Settings>Audio) is no 

longer available.  
 The ‘Maximum number of Participants’ setting was removed from the UI.  
 The Interwise AddIn for PowerPoint (also named PPA) is no longer available. It was 

used to convert PowerPoint presentation into images.  
 The API Manager is no longer available. 
 Built-in Active directory integration is no longer supported. 
 In Breakout Sessions there is no longer an option to send materials (‘project’) to the 

main Moderator.  
 The option to download the Outlook AddIn from the ICC was removed in V7.2. 
 NTR was removed in V7.2. 
 Job titles user attribute in the ICC was removed in V7.2 (Users can still use the remarks 

attribute for that purpose). 
 Self registration to the ICC was removed in V7.2. 
 In V7.0 the Interwise Participant and Moderator applications were merged into one 

application, and, as a result, some features are no longer supported. The following are the 
Moderator features that were in previous versions but have been removed starting V7.0: 
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Feature Description/Workaround 

Self-Exercise mode This option was removed from V7.0, including in the 
following locations:  
 The Self-Exercise button on the Moderator toolbar. 
 The Self-Exercise menu option in the Moderator Tools 

menu. 
 The Self-Exercise mode checkbox in the offline Insert 

dialog box. 
Note: In V7.x, when working with Event Materials created 
by a pre-6.2 Moderator application and which contain files 
inserted with the SEM attribute, when the file(s) are loaded by 
the Moderator they will be opened with an external 
application outside the Whiteboard (as in previous versions), 
but the Participant application will not automatically be 
minimized. In addition, the small floating SEM window (with 
the Raise Hand icon) will not be displayed. 

Background image 
on the Whiteboard  

The ‘Background image’ button, previously part of the 
Moderator toolbar, was removed. From V7.0, a background 
image can be loaded from the Materials tab.  

Default web page 
when starting a Web 
Safari 

This option was removed from V7.0. 

Build Event 
Materials 

This option is now only available with the Materials Editor 
AddIn installed (to be released). 

Statistics window This option was removed from V7.0. 
Feedback pane This pane has been replaced by the Notes tab in V7.x. There 

are no longer pencil icons indicating a new note. 
VOX/Manual 
speaking option 
controls 

In V7.x the Participant application works with a Voice 
Activated or Queued mode; this replaces the Moderator’s 
VOX/Manual controls. 

FTP Compress This option (available from the Miscellaneous tab in the 
Options window) was removed from V7.0. 

VOX speed This option (available from the Miscellaneous tab in the 
Options window) was removed from V7.0. 

Snapshot The option to take a snapshot of the Whiteboard was 
removed. In V7.x you can instead save the Whiteboard 
contents as a .BMP file (from the File menu, select Save 
Whiteboard Contents…). This BMP file can then be 
inserted into Event Materials. 
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Compatibility Issues 

Upgrading Interwise Connect may take a while - big organizations will most likely perform 
the upgrade step by step over several months. Organizations who do not upgrade all of their 
components at once, will have a mixed environment of different versions. This may cause 
compatibility issues. 

Interwise Connect V7.2 can work in a mixed environment with V6.0 and V5.2. An exception 
to this is the Outlook AddIn that was re-designed and re-implemented in V6.0. As a result, 
V6.0 and above of the Outlook AddIn has NO backward compatibility with V5.2 of the 
AddIn.  

To use the new features in V7.2, such as Stream Separation, customers must upgrade all of 
the Interwise components (ICC, Servers, Participant application) to V7.2.  

This document covers compatibility issues that were added in V7.2.   

 
Tip: V7 refers to both V7.0 and V7.2. 

 

Environment 

ICS Vs. ISM  

Px/Push server that works with ISM from V7.0 and above should receive the ICC URL 
without the ‘http://’ or ‘https://’ prefix. Therefore, the ICC URL in the ICC should not 
include it. 

 

ICC Vs. IPP  

 IPP 5.2  IPP 6.0 IPP 7.0 

ICC 5.2 

 

√ Not Supported Not Supported 

ICC 6.0 

 

Not Supported √ √ 

ICC 7.0 Not Supported √ √ 

ICC 7.2 Not Supported √ √ 

It is recommended that both the ICC and IPP will be from version 7.2. If the ICC is from 
V6.0 and the IPP is from version V7.2, ‘on-the-fly’ users will not be able to enter closed 
Moderated Events. The users will be informed that the Event does not exist. 
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ITS and IVR Vs. PX  

 PX 5.2 PX 6.0 PX 7 

ITS and IVR 5.2 √ √ √ 

ITS and IVR 6.0 √ √ √ 

ITS and IVR 7.0 √ √ √ 

 

ITS and IVR Vs. IPP 

 IPP 5.2 IPP 6.0 IPP 7 

ITS and IVR 5.2 √ √ √ 

ITS and IVR 6.0 √ √ √ 

ITS and IVR 7 √ √ √ 

 

ITCS vs. ICS 
 ICS 5.2 ICS 6.0 ICS 7.2 ICS 7.3 

ITCS 7.3    √ 

 

 

Java Participant Application  
The following table lists all features that are not supported with the Java Participant 
application: it compares the features available in the standard Participant application and the 
Java Participant. 

Feature Comment 
Full screen size  
Integrated PowerPoint and DHTML 
PowerPoint - the Java Participant supports only 
PowerPoint slides converted into JPG format. 

Always select to insert/upload PPT 
with ‘static image backup’.  

Video – cannot broadcast video. Can view 2 
video streams but cannot view the still images.   

 

Breakout Session – Java Participant cannot 
participate in Breakout Session.  

When a Java Participant is connected 
to the Event, the Moderator will not 
be able to start the Breakout Session. 

Moderator drawings on HTML pages – the Java 
Participant will only see the HTML page and not 
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Feature Comment 
the drawing. 
Insert Files   
Recording a Live Event  
Protected Recordings  
Online Help  
Save Whiteboard content  
Audio Setup Wizard  
Push of Event Materials - Java Participant users 
receive Event Materials when connected to an 
Event and not beforehand. 

 

Indication on answered questions during Test or 
Survey. 

 

CBT Events  
Use Telephone to enter the Event.  
Voice Activated iMeeting To ensure that Java Participants can 

join the iMeeting, you should un-
check the ‘Allow use of Voice 
Activated mode’ option in the Audio 
tab. 

HTTPS support - Java Participant cannot 
connect to an Event within an HTTPS 
environment. 

 

Reverse Proxy – Java Participant cannot connect 
to an Event behind Reverse Proxy. 

 

 

Converting PowerPoint Presentations to DHTML 
This feature was first introduced in V6.0. 

Uploading, displaying and viewing DHTML presentations require the client applications 
(Participant/Moderator) to be of V6.0 and above.   

When a PowerPoint presentation is uploaded as DHTML with JPEG support, the JPEG 
images can be presented and viewed by applications of versions below 6.0 and by the Java 
Participant. 

Applications of V5.2 and below, including the Java Participant will not be able to view 
PowerPoint Materials uploaded as DHTML only, whether in the Materials pane or when 
loaded on the Whiteboard.  

To upload PowerPoint as DHTML from the ICC, the ICC must be V6.0 and above and the 
user should be using Participant application V6.0 and above.  
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Tip: When converting PowerPoint to DHTML (which is the default in V7.2), it is recommended to 
convert it to 'Dynamic images with static image backup'.  

 
Note: When converting PowerPoint presentations to DHTML using PowerPoint XP or 2003, the 
animations are not supported. 
If you are using PowerPoint XP or 2003 and your presentation contains animations, you should 
convert the PowerPoint to native PowerPoint.   

 

Uploading Event Materials using the Outlook AddIn  
This feature was first introduced in V7.0. 

V6.0 of the Outlook AddIn does not have the capability of uploading Event Materials. With 
V7, you can upload Event Materials only to an ICC of V7. If working with an ICC from 
V6.0, the upload Event Materials tab (in the Outlook AddIn) is disabled. 

 
Note: Outlook AddIn V5.2 cannot work with an ICC from V6.0 and above. 

 

Installing the Outlook AddIn of Localized Office 
Outlook AddIn V5.2 can be installed on Office in any language.  

Outlook AddIn V6.0 can only be installed on Office in the following languages: English, 
Hebrew, Japanese, French, German, Spanish and Simplified Chinese. 

Outlook AddIn V7 can be installed on Office in any language. 

 
Note: The AddIn interface is in English. 

 

My Meeting Room 
This feature was first introduced in V6.0. 

This feature requires an IPP and ICC from V6.0 and above.   

The My Interwise desktop icon and Push Client shortcut icon (with the My Interwise menu 
option) are only available with the Participant application of V6.0. 

Access Meeting Rooms from My Interwise desktop icon 

 ICC 5.2 ICC 6.0 ICC 7 

Participant 5.2  Not supported Not supported Not supported 

Participant 6.0 Not supported √ √ 

Participant 7.0 Not supported √ √ 
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Which Participate version can access Meeting Rooms? 

 ICC 5.2  ICC 6.0 ICC 7 

Participant 5.2  N/A √ √ 

Participant 6.0 N/A √ √ 

Participant 7 N/A √ √ 

Java Participant N/A √ √ 

 

Late Binding 
This feature was first introduced in V6.0. 

This feature requires a Moderator or Participant application, ICC, IPP and all ITS/ IVR 
ICSs to be of V6.0 and above. The feature is disabled when the ICC version is below 6.0. 

 

Assign Names to Phone Only Guests 
This feature was first introduced in V6.0. 

This feature requires that the client applications (Participant/Moderator) and ICSs (ITS, Px) 
be from V6.0 and above, otherwise the feature is not supported. 

 

Voice Activated Mode in iMeeting 
This feature was first introduced in V6.0. 

The Voice Activated iMeeting mode requires a Server Tree and Participant application of 
V5.2 and above. If an iMeeting is configured to allow the use of the Voice Activated mode, 
any connection attempt by a Participant application, ICS or ITS of a version prior to 5.2 will 
be rejected. 

Java Participants cannot connect to an iMeeting that has Voice Activated mode enabled. 

The option to switch from the Queued mode to Voice Activated mode during the iMeeting 
is not supported if the main ICS of the Event Server Tree is of a version prior to 5.2. 

 

Chat Style Notes 
This feature was first introduced in V70. 

V7.0 introduced the new and enhanced displaying of notes, which can be displayed in a chat 
style or Inbox mode, with or without pop-up display.  

  Participant 5.2 or 
below 

Participant 6.0  Participant 7 
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  Participant 5.2 or Participant 6.0  Participant 7 
below 

Participant 5.2 
or below 

 

The feature is not 
supported (notes will 

always pop-up) 

The feature is not 
supported (notes will 

always pop-up) 

V6.0 receives notes 
from V7.0 
Participant without 
the correspondence 
history 

Participant 6.0  

 

The feature is not 
supported (notes will 

always pop-up) 

The feature is not 
supported (notes will 

always pop-up) 

V6.0 receives notes 
from V7.0 
Participant without 
the correspondence 
history 

Participant 7 V7.0 receives notes 
from V5.2 
Participant with the 
sender’s name 
appearing twice 

V7.0 receives notes 
from V6.0 
Participant with the 
sender’s name 
appearing twice 

√ 

 

Participant and Moderator Options 
The standalone Interwise Participant/Moderator Options service program (accessed 
from the Start menu, as shown below) was removed from V7. It was merged into the 
Participant application's Options window (accessed from the File menu). 

 
   

Breakout Session (BOS) 
In V7.0, Interwise developed a new BOS feature.  

This new feature requires that the Participant application and communications tree (Px and 
ITS) will be from version 7.0 and above. Otherwise, the relevant menu items will be disabled 

In addition, if the Moderator is using V5.2 or V6.0 of the Moderator application and tries to 
initiate a BOS, it will not work if one of the PXs in the tree is from V7.0 and above. 
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Closed iMeetings 
iMeetings that have been scheduled on ICC V5.2 or V6.0, will be set as closed iMeetings 
after upgrading the ICC from to V7 

 

Invite Others 
In V5.2/6.0, the Invite Others option was available in iMeetings only.  

In V7, the Inviting Others option from within the Participant application is available for all 
Event types and for all users (Participants and Moderators) as long as the Event is defined as 
'Open'. When the Event (including iMeetings) is closed, the Invite Others menu is disabled.  

The feature requires that both the ICC and Px ICS will be from version 7.0 and above. 

 
Note: Users who are working with V6.0 of the Participant application and join a Closed iMeeting 
on an ICC from V7 will have the Invite menu enabled. In this case, the invitees will be asked to 
enter their username and password in order to join the iMeeting (since it is closed).  

 

Getting Started Page 
The Getting Started page, previously known as the Event Info page, was re-designed in V7.0. 

Participants connecting to previous versions of the ICC will still see the previous version of 
the Getting Started page: 

 Participants/Moderators using V6.0 to enter an Event on an ICC from V7 will see the 
page they used to see in ICC V6.0. 

 Participants/Moderators using V7 to enter an Event on an ICC from V6.0 will see the 
page designed for V6.0 Participants/Moderators. The page includes images that are not 
updated with the V7 interface. 

 
Tip: Starting V7.0, this page can be customized as required. 

 

Help Files 
Starting V7.0, the Help files no longer come as part of the Participant/Outlook AddIn 
application. All Help files are now located on the ICC and are in Web format (instead of 
WinHelp format). The client application pulls the files from the ICC when required. 

In order to view the Participant Help topics, the ICC must be V7.0 and above.   

Users working with V7 Participant application / Outlook AddIn and connecting to V6.0 
ICC or V5.2 ICC, will not be able to view the Help files and will be displayed the following 
message:  
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Users who are working with V5.2 or V6.0 of the Participant application/Outlook AddIn and 
connecting to an ICC from V7 will view the previous Help files (which they have as part of 
their Participant installation).  

 

Long Event Name (255 characters) 
In V7, the Event names can be up to 255 characters in length. In previous versions, it was 
limited to 50 characters.  

The Outlook AddIn (OA) from versions prior to 7.0 limits the Event name to 50 characters 
regardless of the ICC version (including ICC V7). If a user running OA V7.0 creates an 
Event with a name that exceeds 50 characters in a V6.0 ICC, the V7 OA will prompt the 
user with an error message. 

 

Customizing the Event Settings using the OA 
In V7 it is possible to set the Event settings (such as Recording settings) while scheduling 
the Event using the Outlook AddIn. 

The feature requires both the ICC and Outlook AddIn (OA) to be from version 7, otherwise 
the Options tab (in the Outlook AddIn) will not be displayed.  

 
Note: V5.2 of the Outlook AddIn cannot work with ICCs from V6.0 or V7.  

 

Improved Audio Quality for Phone Users 
The audio quality of phone users was improved in V7.0. The feature requires that the phone 
user currently speaking will be connected to an ITS from V7.  

 

Open Questions in the Polls Tab 
The feature requires the Participant application to be from V7.2. 

 

Raise Hand 
The feature requires the Participant application to be from V7.2. 
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New capabilities in iMeeting 
iMeetings are enriched starting version 7.2: 

 Initiate a test – Starting V7.2, it is possible to initiate tests in iMeetings. The feature 
requires the presenter to have Participant application from V7.2. 

 Initiate Over The Shoulder to all participants – Starting V7.2, it is possible to initiate 
Over The Shoulder to all Participants in an iMeeting. The feature requires the Presenter 
to have a Participant application from V7.2. 

 

Support 300 users in iMeeting 
Starting V7.2, users can schedule iMeetings with 300 users. In previous versions, only 100 
users were allowed. This feature requires an ICC from V7.2. 

Attempting to create an iMeeting with more than 100 users using Outlook AddIn V7.2 and 
ICC V7.0 or below will resolved in an Event that is created without any registered users. 

 

Quality of Service (QoS) 
QoS is comprised from separation of the data, voice and video information in to different 
streams. In addition, the QoS support also includes DiffServ Marking on the sent packets. 

The feature requires V7.2 components. If a certain application is below V7.2, this application 
will continue working as before (without QoS support) without affecting the other 
applications in the Event. 

 

Removed Features 
Some the features were removed in V7.2 and are no longer available. Users with a mixed 
environment might face inconsistent behavior as explained below. 

 Protected Recordings – Users with Participant/Moderator application V7.0 and below 
will not be able to work with Protected Recordings when the ICC is from version 7.2. 
Similarly, users will not be able work with Protected Recordings when the ICC is from 
V7.0 or below and the Participant application is from V7.2. 

 Job Titles – There is no backward compatibility issue with this feature. Users importing 
user lists using a previous template that include the Job Title field will not get an error, 
the ICC will simply discard this field. 

 Download Outlook AddIn – Users trying to download the Outlook AddIn by clicking 
a link from an email invitation they received before the ICC was upgraded to V7.2 will 
receive an error message. 
 

Reverse Proxy 
HTTPS 
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HTTPS support requires all the applications to be from version 7. 

Install to Secondary Level URL 

This feature requires all the applications to be from version 7. 

SSO 

SSO support requires all the applications to be from version 7. 
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